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Welcome to your Outlook Introduction training course 

 At the end of this Outlook training you will have a good working knowledge 

of Outlook basics. You will feel more confident using Outlook and be able 

to manage and communicate using Microsoft Outlook. 

 Users may set up meetings across the network, organise their calendar or 

delegate it to someone else, manage their to-do list using Tasks, and even 

leave notes on the desktop.  

 The powerful tools in Outlook in general helps simplify email 

communication, enhance group planning, scheduling of meetings, and also 

allow access to the information you need all from one place. 
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Unit 1 - Introduction and Overview of Outlook  

In this unit you will learn how to: 

 Understand Outlook 

 

Outlook provides an integrated solution for managing your time and 

information. It can make it easier to prioritise and control your time, so that you 

can focus on the things that matter most. 

Outlook is much more than an electronic mailbox 

Office Outlook delivers innovations you can use to quickly search your 

communications, organise your work and share information with others – all 

from one place. 

 

 

 

  

Keep track of daily 

meetings 

Manage and maintain 

your To-Do list 
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Unit 2 - Getting Started 

In this unit you will learn how to: 

 Work in the Outlook environment 

 Use the Outlook user interface 

 Compose and send simple messages 

 Create new messages 

 Understand the message etiquette 

 Use the address book and add recipients 

 Include your signature 

 Save a message 

 Format a message 

 Check spelling and grammar 

 

The Outlook Environment 
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Title Bar Displays the name of the application and the name of the 

current folder. 

Ribbon Toolbar Displays available ribbons 

Help Button Provides help using Microsoft Office online 

Folder Pane The column to the left side of the window that provides 

access to all components of Outlook 

Reading Pane Displays the contents of the selected messages without 

having to open the message. 

Item An item is a basic element created in Outlook that holds 

information and is stored in a specific location. 

 

Items in Outlook include: 

 Messages 

 Appointments 

 Meetings 

 People 

 Tasks 

 Notes 

 

Folder A folder is a container that you can use to store and 

organise Outlook items. 

 

Outlook contains six main components that you can use to communicate with others. 

These components are folders. 

Inbox Where you send and receive messages. 

Calendar Where you schedule appointments, meetings and events. 

People Where you enter and track business and personal 

contacts 

Tasks Where you create and manage tasks 

Journal Where you can automatically track all items that you have 

specified as they occur. 

 

Additional Folders in Outlook Include: 
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Deleted Items Stores any items that you delete in Outlook. 

Drafts Stores copies of unfinished messages you can complete 

and send at a later time. 

Junk E-Mail Contains junk email messages 

Outbox Temporarily stores messages you send until they are 

delivered. 

Sent Items Stores copies of messages you send to others. 

Sync Issues Contains all of the synchronisation logs 

Search Folders Contains views of all mail items that satisfy specific search 

criteria. 

Compose and Send a Simple Message 
You need to send some important information to a client who is located in another 

part of the country. The client needs the information today. Sending it by regular 

mail is not an option. The client is out of the office, so you can’t call either. 

By using Outlook you can quickly and efficiently send the information in a 

simple message. 

E-MAIL 

Electronic mail, or E-Mail, is an application that allows a user to create, send and 

receive electronic messages. You can send information and receive information 

from users within your network of computers or outside your network of 

computers via the internet. 

The Message Form 
When you create a new message using the ‘New E-mail’ button or Ctrl + N, 

Outlook displays a message form that contains text boxes in which you can enter 

specific information. 

In the new message, you'll need to get oriented to the Ribbon. You'll see the 

Message tab on top, which contains the commands and buttons that you're most 

likely to use every time you create and send a message. 

If you're having trouble finding a command or a button, you may need to look 

on another tab. For example, to insert a picture so that it appears in line with the 
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text of your message, (not as a separate attachment), you'll need to switch to the 

Insert tab. 

Note This isn't completely new, but it's something to be aware of: 

 

 Certain groups and buttons will be available only when the insertion point 

is in the body of the e-mail message. For example, formatting commands 

on the Basic Text group won't be available when the insertion point is in 

the To... field or the Subject: field; to use those commands, you need to 

move the insertion point to the body of the message. 

 

 

 

To... Email address or user name of the person to whom you want 

to send the message. 

Cc... E-Mail address or user name of anyone who you want to send 

a copy of the message (carbon copy) to. 

Subject: A brief description of the message 

Message Body The text of the message 
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Default Mail Editor 

 

Microsoft Word is the default mail editor for Outlook. Therefore, when you 

create mail messages you will have access to a number of Word features, making 

it easier to create messages in Outlook. 

E-Mail Etiquette 
Net etiquette or Network etiquette is a set of guidelines for ethical behaviour on 

the internet, including sending and receiving e-mail. You can become a responsible 

internet user by applying the following simple guidelines to your own e-mail 

activity: 

 Think twice before clicking the ‘Send’ button. 

o Once you send an e-mail, you might not be able to take it back. 

o Realise that an e-mail message can be easily circulated (forward, print 

and distributed) 

 Be cautious with humour and sarcasm 

o Statements that are funny person to person might lose their humour in 

writing and appear, instead, confusing or even vicious. 

 Use CAPITAL LETTERS sensibly. 

o Statements in Capitals can suggest you are shouting at the reader. It may 

also be used to highlight important points. 

Use the Address Book to Add Recipients 

 

 

You'll find the Address Book command on the Message tab, OR Click the ‘To’ button (below 

the ribbon.) 
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The Address book is a collection of address books or address lists that you can use 

to find and select names, email addresses and distribution lists to quickly address 

messages. 

Global Address List 

 

The Global Address List is a list of all user names and global distribution lists in 

a particular organisation that is created and maintained by the Microsoft 

Exchange Server Administrator. You can only access the Global Address List if you 

are using a Microsoft Exchange Server email account. 

Show or hide the Bcc field 

 

If you prefer to type e-mail addresses directly in the To and Cc boxes, you may also 

want to know how you can show the Bcc (blind carbon copy) field so that you can 

type names there, too. (You can use Bcc to send messages without exposing 

the names of the recipients to each other — it's one way to respect the privacy 

of the people to whom you're sending e-mail.) 

You will find the ‘Show Bcc’ command under the ‘Options’ tab. 
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Include Your Signature 

 

You can modify existing signatures or create new ones, as well as set a default 

signature, by clicking the arrow under the Signature command which is located in 

the Include group on the Message tab or on the Insert tab. 

1. If you created signatures previously, you'll see them listed here. 

2. To create new signatures, set a default signature, or modify existing 

signatures, click Signatures... 

 

Format a Message 
You need to send a message that contains important dates and times for some 

upcoming events. You want to make sure that the dates and times stand out in the 

message text. By formatting specific text in a message, you will emphasise that 

text, drawing the reader’s attention to it. 

Select the text that you want to emphasise. (To select all the message text, press 

Ctrl +A) 

Apply the format 

Under the ‘Message’ tab in the ‘Basic Text’ group you can find most of the 

formatting tools required. 

 

1 

2 
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Save Message 
While composing a message, you might decide that you are not ready to send the 

message. You can save a message and send it at a later time by clicking on the 

Save Button on the Quick Access toolbar or click the File Tab and click Save. 

The message is stored in the ‘Drafts’ folder. When you’re ready to finish the 

message, simply select it from the drafts folder and continue. 

Checking Spelling and Grammar 
 

Whenever you’re typing, there’s always the possibility of making an error. For 

example you know the correct spelling of the word “their”, but you type it as “their”  

When you are trying to convey a professional image, misspelled words and 

incorrect grammar can make you look unprofessional. 

AutoCorrect 

 

The AutoCorrect feature detects common typing mistakes, including misspelled 

words, grammar problems, incorrect capitalisation and common typos. 

AutoCorrect brings them to your attention. By default, the AutoCorrect feature 

is on. 
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Unit 3 - E-Mail 

In this unit you will learn how to: 

 Attach a file 

 Include a picture 

 Respond to message 

 Forward an message 

 Print a message 

 Delete a message 

Attach a File 
 

You have some information in a separate file that you want to include in a 

message.  Re-typing that information in the message will take some time. You can’t 

copy and paste the information because it’s in a different format. By attaching the 

file to your message you can include the additional information without 

wasting time. 

 

 

 

Where you'll find Attach File 
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Because including an attachment is such a common activity, Attach File is 

available from both the Message tab and the Insert tab. 

File Type and Size 

 

There are a few file type and size guidelines you should follow before attaching files 

or items to an Outlook item. 

Make sure the recipient of an attachment will be able to open and read the 

attachment. The recipient must have the application in which the attachment was 

created or a similar application. 

Be aware of attachment size as a large attachment will use a lot of space and 

might delay the opening of the item to which it is attached. 
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Include a picture in line with text 

In Outlook, it's easy to send pictures in line with the text of your e-mail 

messages instead of as separately attached files. To do this, you would: 

3. Click the Pictures command located on the Insert tab. 

4. When you insert a picture this way, you'll see a picture in line with the text 

of the message as we've shown here. 

Note When you insert a picture into your message, you add it to the 

message as an embedded object. That is, it is a part of the message 

text. To be able to see the picture, people who receive your 

message must be able to receive HTML or Rich Text messages. 

  

 

 

1 

2 
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Tabs that come and go (known as contextual tabs) 

 

Some tabs appear only when you do specific tasks. 

For example, when you: 

5. Select a picture that you have inserted into a message… 

6. …you'll see that Picture Tools appear on the Ribbon. 

7. The Format tab includes commands that you can use to edit the picture 

before you send it. 

When you click away from the picture, Picture Tools disappears. 

You'll see similar behaviour if you include a chart, drawing, diagram, or table in your 

message. 

 2 

3 

 

1 
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Respond to a message 

E-mail isn't just about sending… it's also about receiving and replying. When 

you reply from an open message, you'll use the buttons in the Respond group on 

the Message tab of the Ribbon. 

You'll notice that what's on the Ribbon in a received message is different from 

what's on it for a new mail message. 

Reply Options  

When you want to reply to a message, you have a few options: 

Reply To send a response to the sender of the message. 

Reply to All Send a response to the sender and copies of the response to anyone 

who received the original message. 

Forward Forward a copy of the message to someone who did not receive the 

original. 

The InfoBar  The InfoBar displays information about what has occurred or what 

action you need to take. It is displayed below the active toolbar. 

 



 

www.MicrosoftTraining.net 0207 987 3777 15 

Whoops! Need to recall a message? 

Suppose you've just clicked Send and you realize that a key detail in your message is wrong 

(for example, maybe you wrote "bored" instead of "board" when discussing the results of 

the last board meeting). 

If you're using Microsoft Exchange Server for your e-mail, you may be able to 

recall the message that you just sent. If you act before a recipient reads the 

message, recalling it will allow you to send a corrected version to that person and 

avoid possible embarrassment. Here's what you would do: 

1. In the Folder Pane, click Sent Items to switch to that folder. 

2. In the Sent Items folder, double-click the message that you want to recall 

to open it. 

3. In the open message, click Actions in the Move group, and click Recall This 

Message. 

Note If you don't see the Recall This Message command, it's probably 

because you're not using Microsoft Exchange Server for your e-

mail. 

Forward a Message 
You received a message from a co-worker that you want to share with another co-

worker who didn’t receive the original message. By forwarding the message, you 

can quickly and easily share the information. The only information you need to 

enter is the recipient’s e-mail address. 

 

 

 

 

1 

2 

 
3 
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Print a Message 
Although an advantage of email is that it doesn’t require paper, there will be 

occasions when you will want to have a hard copy of a message, either one 

you’ve sent or one you’ve received. 

1. Open the message you want to print 

2. Click the File tab and select Print to display the print view 

3. To increase the number of copies you want to print, click the Print 

Options button and in the Number of Copies spin box, click the up arrow 

as needed to enter the appropriate number of copies. 

4. If necessary, modify other print options as desired. 

5. Click ‘Print’  

Delete a Message 
 

You have been using Outlook for a while, so your Inbox contains a lot of old 

messages that you no longer need.  By deleting those old messages your Inbox 

will be less cluttered and you will save space on your hard drive. 

To delete a message 

 With message selected: 

 click the ‘Delete’ button on the ‘Home’ tab 

 press the ‘Delete’ button on the keyboard 

 click the ‘Delete’ button on the Quick Access Toolbar (if present) 

 click the ‘Delete’ button on the right side of the selected message (next to 

Flag) 

 right-click the selected message and click the ‘Delete’ option. 

 With message opened: 

 click the ‘Delete’ button on the ‘Message’ tab 

Note All deleted items are by default placed into the Deleted Items 

folder which can be recovered if desired. 

Recover a Deleted Message 

Drag the message from the deleted items folder to any other folder. 
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Unit 4 – E-mail and Contact Management 

In this unit you will learn how to: 

 Work with attachments 

 Use flags and reminders 

 Mark a message as unread 

 Create a folder 

 

Your mailbox is overflowing. There are many messages you’ve received and want 

to keep yet others you no longer need. It’s becoming more difficult to find certain 

messages. By organising your mailbox, it will be easier to retrieve information 

efficiently. 

Preview attachments before you open them 

 

 

Right-Click the attachment 

and choose 'Preview' from 

the menu. 

 



 

18 0207 987 3777  www.MicrosoftTraining.net 

In Outlook , you'll receive attachments just as you did in earlier versions of Outlook. 

And now, some attached files can be previewed right from the Reading Pane.  

Suppose that someone sends you two Microsoft Office Visio diagrams as 

attachments, but you only care about the one that shows the new training room in 

your building. 

How could you quickly decide which file to open or save to your hard disk? 

To preview an attachment, click its icon. The attachment preview appears in 

the Reading Pane. 

Attachment previewing allows you to display previews of certain file types right 

from the Outlook Reading Pane. You can do this without having to open the 

attached files. 

Note: To help keep your computer safe, embedded code in 

attachments is disabled while previewing. 

Once you've decided an attached file is one that you want to open or save, you can do that 

by right-clicking its icon in the Reading Pane and then choosing the appropriate action. 

How others receive attachments that you send 
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How others receive attachments that you send has not changed. What has changed 

is the file format used by some  release programs such as Word  (now .docx), 

PowerPoint  (now .pptx), Excel  (now .xlsx), and Access  (now .accdb). 

This new format keeps file sizes smaller and helps keep files safer. Attachments 

that you send or receive may use this new format. Outlook fully supports sending 

and receiving files that use the new formats 

How others can view attachments that you send 

 

 

Others can download a compatibility pack so that they can open, edit, and save 

documents that use the new Microsoft Office file formats. 

Maybe you're the first person in your workgroup to get the  Office system. Or 

perhaps you work with some departments who need to use Office documents 

saved in an earlier format. You can still share documents with each other. Here's 

how: 

You can open a file created in previous versions of Office, from 95 through 

2003. Just open the file as usual. After working with it in a newer version, you may 

want to save the file. By default, the Save As dialog box saves a file created in 

a previous version as that same version. As you save, a Compatibility Checker 
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will let you know of any new features added to the file that may be disabled, or 

matched as closely as possible. 

 

Note If you open a presentation created in PowerPoint 95, PowerPoint 

will default to the latest format when you save it. But you can 

choose to save the file in the 97-2003 format. 

If you want to save the file in the latest format, select Word Document, Excel 

Workbook, or PowerPoint Presentation in the Save as type box. 

Colleagues who have Word, Excel, or PowerPoint versions 2000 through 2003 (and 

the latest patches and service packs) can open 2013 and 2016 files. When they click 

on your document, they will be asked if they want to download a converter that 

will let them open your document.  
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Use Flags and Reminders 
You receive a message that contains information that you will need to refer to in a 

few weeks. Because you have so many other messages in your Inbox, you’re 

concerned that you will forget to revisit that particular message at the appropriate 

time. 

By flagging the message it will stand out, drawing attention to it. The flag will 

ensure that the message is easy to find and is a reminder to refer back to the 

message. 

Flags and reminders can help you and others remember to do things.  

To add a flag or a reminder (or both) when you're creating a message, start by 

clicking Follow Up in the Tags group of a new e-mail message. 

Follow Up for Yourself 

Suppose you send a message to a colleague that says "I'll follow up with you 

tomorrow." To be sure that you remember to do that, flag the message for 

yourself by clicking Follow Up and then clicking Tomorrow. The message 

(which is moved to the Sent Items folder once you send it) is flagged and added 

to your To-Do List in Tasks list. It also shows up as an item on your own To-Do 

Bar. 
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Follow Up for the Recipient 

You can also attach a follow-up flag for your recipients by using the Custom 

option and then selecting the Flag for Recipients check box. Before you send the 

message, you specify when you want the recipient to be reminded to follow 

up with you. 

 

The received message will include a flag and the bell icon (indicating that the 

message includes a reminder). As long as the recipient keeps the message in his or 

her Outlook mailbox, a reminder will be displayed at the time you specify.  

Note  The item will NOT be added to the recipients To-Do Bar — 

creating a to-do list is a matter of personal choice.) 

Mark a Message as Unread 
You can manually change the status of a message from read to unread. 

1. In the Inbox select the message you want to mark as unread 

2. In the Tags group click the Unread/Read button OR 

3. Right-click the message and click Mark as Unread 
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4. In the Inbox, the message is now bold and has a closed envelope symbol, 

indicating an unread message. 

Automatically Mark Messages as Read in the Reading Pane 

5. Select the File tab and click ‘Options’ 

6. Select the Mail category 

7. From the Outlook Panes section click ‘Reading Pane’ 

8. Select the ‘Mark items when read when viewed in the Reading Pane’ check 

box and then type a number in the Wait in seconds before marking item as 

read box 

 

Create a Folder 
If necessary, click the Mail button on the Folder Pane to display the mail folders 

If you want the new folder at the top level, right-click Personal Folders, (or 

whatever name you have assigned to the top level) select New Folder from the 

context menu. Otherwise, right-click the folder that you want the new folder in, 

select New Folder from the context menu. 

9. Outlook displays the Create New Folder dialog box. The location for the new 

folder is shaded in the folder display. 
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10. You can, if necessary, change the location at this point 

11. Type the name of the new folder in the Name box 

12. Make sure that Mail and Post Items is selected in the Folder Contains list 

Copy Messages to Folders  

You might receive messages that contain information on more than one 

subject. It would make organising more efficient if you could save those messages 

into more than one folder. 

13. Select the message you want to copy 

14. In the Home ribbon from the Move group, click the Move button then click 

Copy to Folder 

15. In the Move Items dialogue box select the folder to which you want to copy 

the message and click OK 

Delete a Folder 

16. In the ‘All Mail Folders’ pane, select the folder you want to delete. 

17. On the Home tab click the ‘Delete’ button OR 

18. Right-click the folder to be deleted and click ‘Delete Folder’ 

19. In the message box, click ‘Yes’ to confirm the deletion of the selected folder. 
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Unit 5 – Appointments and Events 

In this unit you will learn how to: 

 Work with the Outlook calendar 

 Create an appointment 

 Change an appointment 

 Delete an appointment 

 View calendar snapshot 

 Send an Outlook calendar in an Email message 

 

You have discovered how Outlook helps you to communicate electronically and 

manage those communications. You can also keep your schedule organised 

electronically by using the calendar. 

Your paper calendar is a mess. You’ve scheduled, re-scheduled and cancelled 

appointments. There are scribbled notes posted on certain days as reminders. By 

using the Outlook calendar your schedule will always be up to date and easy 

to read. 

The Outlook Calendar 

Before you use the calendar you will need to become familiar with its components 

and how they work. By understanding the basics of the calendar you will have a 

solid foundation upon which to build more critical skills. 

You can schedule activities in your Outlook calendar as appointments, meetings, 

events, or tasks.  

Your choice of entry type will depend on who else is involved and how you want 

the entry to appear.  

By selecting entries in your calendar correctly, you'll know at a glance what's going 

on, when, and with whom. 

See Your Calendar 
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Before you can see what's in your calendar, you need to know how to find it. Here 

are two quick ways to see the calendar: 

 Click Calendar in the Folder Pane.  

 Click a date on the Date Navigator (which you'll find at the top of the To-

Do Bar if active).  

 

Once you're looking at your calendar, you can use the Home ribbon buttons to 

navigate and to show detail:  

 

1. Click Day, Work Week, Week, Month or Schedule View to quickly switch 

views. 

2. Forward and Back buttons allow you to easily move through your calendar. 

Know Your Choices 

The four most common occurrences on the calendar are: 

1. Appointment:  An appointment is an activity that involves only you, at a 

scheduled time. 

1 

2 
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2. Meeting:  A meeting occurs at a scheduled time, like an appointment. 

The difference is that you invite other people by using a 

meeting request that's sent via e-mail. 

3. Event:  An event is an activity that lasts all day long. Unlike an 

appointment or meeting, an event doesn't block out time in 

your calendar. With an event, you can still have other entries 

appear in your schedule for that day. 

4. Task:  A task is an activity that involves only you, and that doesn't 

need a scheduled time. New to Outlook 2007 and continued 

with Outlook  is an area in your calendar's Day and Week 

views that shows tasks. 

Just You? Use an Appointment 

Appointments are activities that you schedule in your calendar that do not involve 

inviting other people or reserving resources. You can schedule recurring 

appointments, view your appointments by day, week, or month, and set 

reminders for your appointments. 

You can specify how the appointments in your calendar look to others by 

designating the time of the appointment as busy, free, tentative, or out of office. 

Also, others can give you permission to schedule or make changes to appointments 

in their calendars. 

Create an Appointment 

1. On the Calendar Home ribbon, click New Appointment button.  

2. Keyboard shortcut to create an appointment, press Ctrl + Shift + A. 

3. In the Subject box, type a description.  

4. In the Location box, type the location.  

 

Enter the start and end times.  

Note By default, the current time zone setting on your computer 

system is used to schedule appointments. If you want to 

schedule your appointments based upon an alternate time zone, 

on the Appointment tab, in the Options group, click Time 

Zones. 
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Tip You can type specific words and phrases in the Start time and End time 

boxes instead of dates. For example you can type Today, Tomorrow, New 

Year’s Day, Two Weeks from Tomorrow, Week from Yesterday, Three 

days before New Year's Day, and most holiday names. 

 

Select any other options that you want.  

To make the appointment recur, on the Appointment tab, in the Options group, 

click Recurrence .  

Click the frequency (Daily, Weekly, Monthly, Yearly) with which the appointment 

recurs, and then select options for the frequency.  

Click OK.  

On the Appointment tab, in the Actions group, click Save & Close. 

One quick way to start an appointment (or any calendar entry, for that matter) is 

to rest the pointer over the desired time in Day view, click, and type the details.  

5. Rest the pointer over the desired time in your calendar and click. 

6. Type the details. 



 

www.MicrosoftTraining.net 0207 987 3777 29 

7. Need more time for your appointment? Simply drag the bottom handle to 

make the appointment    longer. 

 

Assign a Colour Category To a Calendar Appointment 

You can track all items related to a particular project or task by using colour 

categories to easily identify and organize the items. Besides calendar items, you 

can assign colour categories to contacts, messages, tasks and notes. 

Colour categories connect your calendar items for easy identification. The 

colour categories connect you to other related items too, such as messages or 

contacts. 

 

A category must be listed in the Colour Categories list before you can assign it. If 

it is not listed, you can simultaneously create a new colour category and assign it 

to an item for the first time. You can also choose from several default colour 

categories and rename them to be more meaningful to you. 

To assign a colour category, do the following: 

 For an appointment in Calendar 

o Right-click the appointment, point to Categorise , and then click a 

colour category.  

 For an open appointment 

o On the Appointment tab, in the Tags group, click Categorise , and 

then click a colour category.  
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 For an open meeting request 

o On the Meeting tab, in the Tags group, click Categorise , and then 

click a colour category.  

 For an open recurring meeting request 

o On the Recurring Meeting tab, in the Tags group, click Categorise , 

and then click a colour category.  

To see more categories or to create a new category 

Click All Categories to open the Colour Categories dialog box. To assign a colour 

category from the Colour Categories dialog box, you must select the check box 

next to the colour category. The Colour Categories dialog box is also a quick way 

to assign multiple categories to an item. 

 

The first time that you assign a default colour category to an item, you will be 

prompted to rename the category. At this time, you can also change the colour of 

the category and choose a keyboard shortcut. 

Note You can change the colour associated with a category at any 

time.  

Another way to open the Categorise menu and Colour Categories dialog box is by 

selecting a meeting in the Calendar. This opens the Calendar Tools contextual tab 

where you will find the Categorise button in the Tags group.  

Only the 15 most recently used colour categories appear on the Categorise menu. 

To see the rest, click All Categories on the Categorise menu. 

Change an appointment 

Open the appointment, event, or meeting that you want to change.  

Do one of the following:  

1. Change options for an appointment that is not part of a series 

a. On the Appointment tab, change the options, such as subject, 

location, and time that you want to change, then, click 'Save and 

Close.'  

Change options for all items in a series 

b. In the Open Recurring Item dialog box, click ‘The entire series’.  
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c. On the Appointment tab, change the options, such as subject, 

location, and time that you want to change.  

d. To change recurrence options, on the Appointment tab, in the 

Options group, click Recurrence. Change the options, such as time, 

recurrence pattern, or range of recurrence, and then click OK.  

Click Save and Close.  

Change options for one item that is part of a series 

e. In the Open Recurring Item dialog box, click ‘Just this one’.  

 

f. On the Appointment tab, change the options, such as subject, 

location, and time, that you want to change, and then click Save 

and Close 

Tip In Calendar, you can drag the appointment, event, or meeting to a 

different date. You can also edit the subject by clicking the 

description text and typing your changes.  
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You can change an event into an appointment, causing the time to be blocked out 

in your calendar, by clearing the ‘All day’ event check box and then entering the 

start and end times of your choice.  

Events are defined as lasting from midnight to midnight; clearing this check box 

allows you to enter specific start and end times. 

Deleting Appointments 
1. Select the appointment (hold down Ctrl or Shift key to select more than one 

item) 

2. Right click and delete or on Calendar Tools Appointment ribbon click Delete 

button in the Actions group or delete on keyboard. 

3. If the appointment is part of a series you must choose between deleting the 

single occurrence or the entire series. 

 

View a Calendar Snapshot 

A Calendar Snapshot is sent to you in an e-mail message in the iCalendar format. 

It is a static calendar that can be updated only after the calendar owner sends you 

a new Calendar Snapshot. There are two ways in which you can view the calendar 

information in a Calendar Snapshot — in the message body or as an additional 

calendar in Calendar view in Outlook. 

Open the calendar as an additional Outlook calendar  

4. Select the message that has a Calendar Snapshot. 

If you use the Reading Pane, the calendar appears in the message body. 

If you have turned the Reading Pane off, open the message to see the calendar in 

the message body. 

Do one of the following: 

 If you are using the Reading Pane  

o In the Reading Pane, click Open this calendar. 

 You have opened the message in a separate window  

o On the Message tab, in the Open group, click Open this calendar. 

If you know and trust the source of the calendar, click Yes at the prompt, and then 

click Add this Internet Calendar to Outlook. 
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The Internet Calendar opens in side-by-side view in the Outlook Calendar and is 

added to the Folder Pane in Calendar view under Other Calendars. 

 

 

Notes: To remove a calendar from side-by-side view, clear the check 

mark for the calendar in the Folder Pane. 

 To overlay multiple calendars, use the arrow buttons on the 

calendar tabs. 

 You can drag items from the Calendar Snapshot to other 

calendars in side-by-side view 

 To remove the Calendar Snapshot from the Folder Pane, right-

click the name of the calendar, and then click Delete calendar 

name. 

 

View the calendar in the body of an e-mail message 

 If you use the Reading Pane, the calendar appears in the message body. 

 If you have turned the Reading Pane off, open the message to see the 

calendar in the message body. 
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Send an Outlook  calendar in an email message 

A copy of your calendar can be sent to anyone in an email message. The calendar 

is included as an attachment and also appears within the message body. You decide 

what dates are included and the amount of detail. 

5. In Calendar, on the Home tab, in the Share group, click E-mail Calendar. 

 

1. In the Calendar list, choose the calendar to send. By default, the default 

Calendar is chosen. This is the Outlook calendar that is used to display your 

free/busy information to others and where meeting requests are accepted. 

2. In the Date Range list, choose the amount of calendar data to include in 

your message, or click Specify dates to enter a custom date range. 

Tip:  If you choose a large date range or select Whole calendar, you might 

create a large message. 

3. In the Detail list, choose the amount of detail to show the recipients. By 

default, the Availability only option is selected. None of the options include 

your items marked private unless you change the privacy option in 

Advanced options. 
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4. Optionally, you can restrict the information included in the message to your 

working hours by selecting the Only show time within my working hours 

check box. To change your working hours, click Set working hours. 

5. Optionally, to see advanced options, click Show. 

 Include details of items marked private This option requires Detail to 

be set to Limited Details or Full Details. The existence of private items 

is included, but no further information is shared. 

 Include attachments within calendar items This option requires Detail 

to be set to Full Details. All attachments on calendar items, such as 

spreadsheets, are included.  

 E-mail Layout You can include your Daily schedule or a List of events. 

6. Click OK. 
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7. In the To box, enter the name of the person to whom you want to send the 

subscription information. 

8. In the message body, enter any information you want to include. 

9. Click Send. 

The calendar appears to the recipient within the message body. The attached 

iCalendar file with a file extension of .ics can also be opened in many calendar 

programs, including Outlook. 

When an .ics file attachment is received in Outlook, the recipient is prompted to 

open the calendar. An .ics calendar file opens as a new calendar within Outlook. 

When opened as an Outlook calendar, the recipient can view the received calendar 

in side-by-side or overlay views. The recipient can also drag calendar items from 

the received calendar to another Outlook calendar. 
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Unit 6 – Meeting Requests and Responses 

In this unit you will learn how to: 

 Schedule a meeting 

 Fill in the meeting form 

 Reply to meeting request 

 Cancel a meeting 

 Print the calendar 

You need to schedule a department meeting. You must notify all employees, 

reserve a slide projector and determine who will be attending. 

By using Outlook, you can electronically communicate and track attendance of 

participants and resources at meetings from one central location. 

Schedule a Meeting 
When you scheduled appointments that involve your schedule only, all you had to 

do was enter the information in your calendar. 

Now, you will combine two of the tasks you’ve already learned – sending mail 

messages and scheduling appointments to schedule meetings that involve 

multiple participants. 

You need to schedule a department meeting. You could invite the participants by 

phone but that will take some time, especially if someone is not available at the 

designated time. By scheduling a meeting in Outlook you can quickly invite the 

appropriate participants and resources all at the same time and you can pick 

a time that is convenient for everyone. 

The Meeting Scheduling Process 
1. The process begins with a Meeting form that you complete and send to all 

the meeting participants. 

2. The meeting is scheduled on your calendar as soon as you send the 

meeting form. 

3. As each participant accepts or tentatively accepts the meeting, it is 

inserted into their calendar and a response is sent to you, the meeting 

organiser. 

4. If the meeting is declined or a new time proposed a reply is sent. 
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The Meeting Form 

The meeting form is used to invite participants to a meeting. It has three buttons 

in the Show group located on the Meeting ribbon which are used to setup meeting 

requests: 

 The APPOINTMENT button 

o Allows you to enter a subject, a location for the meeting, start and end 

times and any other information regarding the meeting. 

 The SCHEDULING button 

o Allows you to co-ordinate the meeting to fit the schedules of all 

attendees. 

 The TRACKING button (This section is not visible until the meeting form is 

sent to the participants... see page 61 for screenshot.) 

o Displays the meeting participants and their replies. 

 

Meeting Resources 

A Meeting Resource is an item with its own e-mail account on the Microsoft 

Exchange Server that you can use to schedule for a meeting. It will 

automatically accept or reject meeting invitations. 
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Schedule an In-Person Meeting 
5. On the Home ribbon, in the New group, click New Meeting.  

a. Keyboard shortcut. CTRL + SHIFT + Q 

In the Subject box, type a description.  

In the Location box, type a description or click Rooms to choose from rooms 

available for automatic scheduling by using Microsoft Exchange.  

In the Start time and End time lists, select the start and end time for the meeting. 

If this is an ‘all day event’, select the ‘All day event’ check box.  

An ‘all day event’ is a full 24 hour event lasting from midnight to midnight. 

Note By default, the current time zone setting on your computer 

system is used to schedule meetings. If you want to schedule 

meetings based upon an alternate time zone, on the Meeting 

tab, in the Options group, click Time Zones. 

Type any information that you want to share with the recipients, attach any files, 

or create a Meeting Workspace. 

On the Meeting tab, in the Show group, click Scheduling.  

b. The Scheduling view helps to find the best time for your meeting. 

Click Add Others, and then click Add from Address Book.  

In the Select Attendees and Resources dialog box, in the Search box, enter the 

name of a person or resource that you want to invite to the meeting. If you are 

searching with the More Columns option, then click Go.  

Select the name from the results list, click Required, Optional or Resources, and 

then click OK.  

g. Required and Optional attendees appear in the To box on the 

Meeting tab, and Resources appear in the Location box. 

h. The free/busy grid shows the availability of attendees. A green 

vertical line represents the start of the meeting. A red vertical line 

represents the end of the meeting. 
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For Exchange accounts, the Room Finder pane contains suggested best times for 

your meeting (when most attendees are available). To select a meeting time, click 

a time suggestion in the Room Finder pane in the Suggested times section, or pick 

a time on the free/busy grid. 

 

If you want to make the meeting recur, on the Meeting tab, in the Options group, 

click Recurrence, select the recurrence pattern, and then click OK.  

When you add a recurrence pattern to a meeting request, the Meeting tab changes 

to Recurring Meeting. 

On the Meeting tab, in the Show group, click Appointment.  

Click Send.  
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Reply To a Meeting Request 
You receive a meeting invitation from a co-worker. You could call her and tell her 

that you will be attending but what if she (or you) forgets to document your 

participation? 

 

 

By using Outlook to reply to a meeting request, the meeting organiser will be 

assured of your attendance and it will also be documented in your calendar. 

ACCEPT  

1. Open the meeting request.  

2. Click ‘Accept’ on the Meeting 

ribbon 

3. Choose one of the following: 

a. Edit Response before 

Sending 

b. Send the Response 

Now 

c. Do Not Send a 

Response 

DECLINE 

4. Open the meeting request 

5. On the ‘Meeting ribbon, in the ‘Respond’ group, click ‘Decline' 
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6. Choose one of the following: 

a. Edit Response before Sending 

b. Send the Response Now 

c. Do Not Send a Response 

7. In the meeting request, on the ‘Meeting Response’ tab, in the 'Action’ group 

click ‘Delete’. 

Meeting Conflicts 

When you open a meeting request for a meeting that conflicts within another 

appointment in your calendar, Outlook alerts you by displaying a warning 

InfoBar. 

Conflicting meetings are displayed adjacent to each other on the calendar. 

Propose New Meeting Times 

You receive an invitation to a meeting which you need to attend but you are not 

available at the scheduled time. 

You could decline the invitation and compose a new message suggesting an 

alternate meeting time. To save time you could propose a new meeting time for 

the meeting. 

 

1. In the open meeting request, on the Meeting ribbon, in the Respond group, 

click Propose New Time.  

Note If you open the meeting from your calendar, on the Meeting 

ribbon, in the Respond group, click Propose New Time. 

Click either Tentative and Propose New Time or Decline and Propose New 

Time.  

Click a time when all invitees are available. 
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Click Propose Time.  

Click Send.  

Microsoft Office Outlook  sends a default message saying that you want to 

propose a new time but you have tentatively accepted the meeting. You can 

change this default message to say that you want to propose a new time, 

and that you are declining the meeting: 

Select the File tab, click Options > Calendar > Calendar Options.  

In the Use this response when you propose new meeting times list, click the 

setting that you want.  

Track Meeting Responses 

You have a department meeting scheduled for tomorrow. You need to determine 

exactly how many people will be attending so you can make the necessary 

preparations. 

By using Outlook, you can quickly track who has responded and who has not 

responded to the meeting request. 
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Display the Calendar 
1. Display the date on which the meeting is scheduled. 

2. Double click the meeting to open the meeting form 

3. From the Meeting ribbon select the Tracking button in the Show group. 

 

Update a Meeting Request 

You have a meeting on the wrong day. You intended for the meeting to be on a 

Monday rather than a Tuesday. 

You could send cancellation notices and new meeting invites but that will require 

a lot of work on your part and generate a lot of mail for all the attendees of the 

meeting. 

An easier and quicker solution is to reschedule the meeting by updating the 

meeting request. 

4. Open the Meeting Form 

5. Make the appropriate changes 

6. Send Update 

Cancel a Meeting Request 

You have a meeting scheduled for tomorrow. A large number of participants are 

attending. You have a conflict, so you’re going to have to cancel the meeting. 
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You don’t have time to call everyone. Luckily, you can use Outlook to quickly solve 

your problem. When you cancel a meeting in Outlook, each participant is 

automatically notified. Therefore, you won’t have to worry about a participant 

turning up for a meeting that has been cancelled. 

In addition, participant’s calendars will be cleared so they can attend other 

potential meetings instead. 

The only person who can cancel a meeting is the meeting organizer. The 

meeting organizer is the person who sets up the meeting by choosing who to invite 

and sending the meeting request to those people. As an organizer, you can cancel 

a one-time meeting, a recurring meeting, or one or more instances of a recurring 

meeting. 

Cancel a One-Time Meeting 
1. In Calendar, open the meeting.  

2. On the Meeting ribbon in the Actions group, click Cancel Meeting.  

Important If Cancel Meeting is not on the Actions menu, you are not 

the meeting organizer, and you can't cancel the meeting. 

Click Send Cancellation and delete meeting 

Cancel a Recurring Meeting 

3. In Calendar, open the meeting.  

4. In the Open Recurring Item dialog box, click Open the series, and then 

click OK.  

5. On the Meeting Series ribbon, click Cancel Meeting then click Send 

Cancellation.  

Cancel An Instance Of a Recurring Meeting 

6. In Calendar, open the instance of the recurring meeting.  

7. In the Open Recurring Item dialog box, click Open this occurrence, then 

click OK.  

8. On the Meeting Occurrence ribbon, click Cancel Meeting 
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Important If Cancel Meeting is not on the Actions group, you are 

not the meeting organizer, and you can't cancel the 

meeting. 

In the Confirm Delete dialog box, click Delete this occurrence then click Send 

Cancellation.  

Note If you are a meeting attendee — that is, if the organizer invited 

you to the meeting —you can only decline the meeting or, if 

allowed by the organizer, propose a different meeting time.  

Whether you cancel or delete a meeting, make sure that you click Send cancellation 

and delete meeting, and then send the cancellation to everyone you invited. It is 

poor meeting etiquette — not to mention inconsiderate — to cancel a meeting 

without notifying the people you invited. 

Print the Calendar in Outlook 

You are going to be out of the office on business. You have a number of meetings 

scheduled while you are away but you won’t have your laptop with you. 

By printing a copy of your calendar before you leave you won’t have to worry about 

missing a meeting. 

 

With the calendar open: 

1. Select the File tab and choose ‘Print’ 

2. From the Settings area select the Style you want 

3. Select Print Options 

4. In the Print Range box, specify the Start Date and End Date 

5. If necessary select other Print Options 

6. Click ‘Print’ 
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Unit 7 - Managing Contacts 

In this unit you will learn how to: 

 Add contacts 

 Fill in the contact form 

  

 

You have quite a collection of business cards; however, that fax number you need 

in a hurry always seems hard to find. 

Outlook makes it easy to organise all the information you need about your 

business and personal associates. Names, addresses and phone numbers are easy 

to search and easy to retrieve and update. 

Add a Contact 

Because an external client does not work for your company, his e-mail address is 

not in the Global Address List. Every time you send him a message you have to type 

his e-mail address which is, georgemesserschmidt@msmoveandstore.com. You 

have on several occasions misspelled the e-mail address, therefore, having the 

message bounce back as undeliverable. 

By adding George’s e-mail address to Outlook once, you can quickly retrieve it 

whenever you need it, saving typing time and avoiding undeliverable messages. 

Contacts 

A Contact is a person with whom you communicate on a business or personal level 

and whose personal or business (or both) information is stored in the People 

Folder. 
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The Contact Form 

 

When you create a new Outlook contact, Outlook displays a Contact form that 

contains text boxes in which you can enter personal and business information. 

The Outlook Address Book 

The Outlook Address Book is a list that contains all contacts that you create by 

using the Contact form.  

In Office Outlook , each of your contacts is also displayed as an Electronic 

Business Card which is a view of specific information about a contact, in a format 

similar to a paper-based business card, that can be inserted into messages. Any 

information that you add to a contact is automatically made to the corresponding 

Electronic Business Card, and vice versa.  
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7. A contact form that contains Melinda Perry’s information. 

8. A view of the Edit Business Card dialog box, with the corresponding fields 

filled in for Melinda Perry’s Electronic Business Card. 

Create a Contact 
1. Select People from the Folder Pane and on the Home ribbon click New 

Contact.  

a. Keyboard shortcut - Ctrl +Shift +C 

Type a name for the contact.  

Enter other information that you want to include for the contact.  

Save and Close. 

Note To specify how you want the contact's name to appear in the 

To... line of a message, type a name in the Display As box.  

To enter multiple entries for a field, such as more than one phone number or e-

mail address, click the down arrow next to the field. If you have more than one 

mailing address for a contact, select the 'This is the mailing address check box' to 

establish which address is to be used during a mail merge. 

Tip You can quickly create another contact with the same company 

information. In the current contact, on the Contact ribbon click the Save 

& New button in the Actions group and select Contact from the Same 

Company. 

1 

2 
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Create a contact from another contact 

You can create a new contact from an existing contact by using the existing 

contact as a template, and then changing any of the information, as necessary. 

1. In Contacts, in Business Cards view, click the contact that you want to use as 

a template.  

Note You can also complete this procedure in the Address Cards and 

Detailed Address Cards views.  

2. Press CTRL + C, and then press CTRL + V.  

3. In the Duplicate Contact Detected box, select the Add new contact option.  

4. When you save a contact or an Electronic Business Card with the same name 

or e-mail name as one that already exists in your Contacts folder, Outlook 

will create an exact copy using the same name etc. 

Note  Microsoft Office Outlook displays a dialog box with options to 

either add the duplicate contact as a new contact or update the existing 

contact with the new information from the duplicate contact. 

5. Click Add.  

6. The new contact will appear in Business Cards view next to the contact you 

copied. 

7. Double-click the new contact to open it, and then edit the information, as 

needed.  

8. Click Save and Close. 

Create a contact from an e-mail message that you 

receive 
9. Open or preview the e-mail message that contains the name that you want 

to add to your contact list. 

10. Right-click the name of the sender who you want to make into a contact, 

and then click Add to Contacts on the shortcut menu. 

Note In Outlook, there is no option to add contact information 

automatically to Contacts or the Address Book when you reply to a contact.  
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Create a contact from an Electronic Business Card 

that you receive 

When you save an Electronic Business Card received in an e-mail message, you 

create a new contact. If you already have a contact by the same name, you can save 

the duplicate as a new contact or update the original. 

1. In an open message, right-click the card, and then click Add to Contacts 

on the shortcut menu. The new contact opens in the contact form.  

a. On the Contact tab, in the Actions group, click Save & Close.  

If you already have a contact with the same name, Outlook detects the duplicate. 

Do one of the following:  

i. Select Add the new contact. This creates a duplicate contact, 

including a contact form and Electronic Business Card.  

j. Select Update the information. Existing duplicate contacts are 

listed. Double-click the contact to update it, and then update the 

information on the contact form and save it. 

 

Note The new contact information is now saved in Contacts and is 

available as an Electronic Business Card as well as in other views. 

You can make changes to the contact information both before 

and after you save it. 

 

Note You can also right-click the attached .vcf file in the message 

header to open the shortcut menu and add the contact or 

choose other options.  

If you click the Save & New option in the contact form, the open contact is saved, 

and a new, blank contact form opens. 

Edit a Contact 

Contact information changes frequently. Whether it’s an updated address or phone 

number. Outlook puts an end to messy address books or card files. Your contact 

information will be neat and easy to read. 

1. Open the Contact form  

2. Double click the contact or right click and select Open 

3. Edit the appropriate information 

4. Save and Close 
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Delete a Contact 

Your address book contains a number of contacts with whom you no longer do 

business. 

By deleting those old contacts your address book will be less cluttered and you will 

save space on your hard drive. 

1. Select the contact 

2. Click the Delete button on the Home ribbon located in the Delete group

 OR 

3. Right click and select ‘Delete’ 

Print Contacts 
1. Select the ‘File tab’ and choose ‘Print’ 

2. Select a print style from the Settings 

3. If necessary select Print Options 

4. Click ‘Print’ 
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Unit 8 - Managing Tasks 

You are in the middle of writing a message and think of something else that 

needs to be done. You could scribble yourself a note, hoping that it doesn’t 

get lost in the shuffle. 

A better option is to enter the task in Outlook. You will then have an 

electronic reminder of what needs to be done 

and when. 

 

 

 

About Tasks and To-Do Items 

A task is an item that you create in Outlook to 

track until its completion.  

A to-do item is any Outlook item — such as a 

task, an e-mail message, or a contact — that has 

been flagged for follow-up.  

By default, all tasks are flagged for follow-up when 

they are created, even if they have no start date or 

due date. Therefore, whenever you create a task, or 

flag an e-mail message or a contact, a to-do item is 

created automatically. 

When you need to quickly indicate that an item 

requires your attention at a later time, flagging 

is the best option.  

When you flag an item, it is displayed with a flag 

in the Mail view, in Tasks, in the To-Do Bar, and in 

the Daily Task List in Calendar.  
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Flagging a message or contact does not create a new task. This is because 

the to-do item is still an e-mail message or contact after being flagged, and 

therefore you do not have the ability to assign it as a task to someone else, or 

indicate its progress or percentage of completeness.  

A task can occur once or repeatedly. A task can repeat at regular intervals, 

or it can repeat based on the date that you mark the task complete. For 

example, you can create a recurring task to send a status report to your 

manager on the last Friday of every month, or create a recurring task to get a 

haircut one month after your last one. 

Both tasks and to-do items appear in Tasks, in the To-Do-Bar, and in the 

Daily Task List in Calendar. No matter which view you are in, the To-Do Bar 

keeps you informed of your calendar, task, and to-do items. 

There are several ways to create a new task in Outlook: - 

1. Select Tasks from the Folder Pane and on the Home ribbon click New Task 

in the New group 

2. Enter a task in the Type a new task text box in the To-Do Bar 

3. Type in any blank space in the Daily Task List in Calendar 

4. Click and type in the Type a new task text box at the top of Tasks view. 

Note: Of these, the fastest way is to use the To-Do Bar. 

5. You can also create a task by dragging an item, such as an e-mail 

message, to Tasks in the Folder Pane. A copy of the e-mail message is 

then created as a task. You must Save and Close the new task. 

6. On the Home ribbon in the New group click New Items then select Tasks 

Note: Item 6 can be carried out from Mail, Calendar, Contact, Tasks 

or Notes view 

Whether you track tasks that are assigned to yourself (such as reminders to 

respond to e-mail messages), or track tasks that are assigned to other people 

(such as the progress of someone's project), Outlook tasks are your solution. 

You can quickly add and update tasks, or mark them as complete. With tasks 
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incorporated into the Calendar view, you have a rich interface for keeping track 

not only of your appointments, but of the tasks that you need to complete on 

a given day as well. 

Create a Task From the Home ribbon 
1. In the New group on the Home ribbon point to New Items, and then click 

Task.  

a. Keyboard shortcut >To create a new task, press CTRL+ SHIFT+ K 

2. In the Subject box, type a name for the task.  

Note You have now entered enough information to create a task. The 

following steps are optional, but will help you better manage 

your tasks in Outlook. 

3. On the Task ribbon, in the Actions group, click Save & Close or continue 

with the following steps to customize your task.  

4. If you want, set the Start date and the Due date for the task.  

 Note If you specify a Start date, the Due date field is automatically set 

to the same day. You can change the Due date field to any date 

that you want. 

5. If you want to make the task recur, on the Task ribbon, in the Recurrence 

group, click Recurrence.  

6. In the Task Recurrence dialog box, click the frequency (Daily, Weekly, 

Monthly or Yearly) with which the task should recur, and then do one of the 

following:  

k. Make the task recur based on a regular interval. In the Recurrence 

pattern section, select the options for the frequency interval that you 

want. Do not select Regenerate new task, or the task will not recur at 

regular intervals.  

l. Make the task recur based on completion date. Select Regenerate 

new task, and in the box, type the amount of time after which a new 

task must be generated.  

7. Each time that you mark the task complete, a new task will be created 

based on your specifications.  

Tip This is your best choice when you do not want the next reminder for a task 

to appear until the previous one is marked as complete. If you do not mark 

the item complete, the next reminder will never appear. For example, if you 
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have a reminder to pay your utility bill on the 15th of each month and you 

do not mark the occurrence on April 15th as complete, in May you will still 

see the not yet completed April 15th task. Only after you mark the April 

15th task as complete does the May 15th occurrence of the task appear. 

8. Click OK to close the Task Recurrence dialog box.  

9. If you want to add a reminder alert, select the Reminder check box, and 

then enter the date and time for the reminder.  

1. You can specify a custom sound to be played with your reminder. Click 

, click Browse, select the sound file to play, click Open, and then click OK. 

This changes the reminder sound only for this task.  

2. If you want to track your progress on this task, in the Status, Priority, and 

% Complete boxes, enter the values that you want.  

 

Note The 'Status' and '% Complete' fields are linked and when you 

change the value in either field, the value in the other field 

changes accordingly.  

Status % Complete 

Not Started 0 

In Progress 1-99 

Completed 100 

Waiting on someone else 0-100 

Deferred 0-100 

  

 

If you want to assign a colour category to your task, on the Task tab, in the 

Options group, click Categorise, and then click one of the colour categories on 

the menu. For more colour categories, click All Categories.  

The first time that you use a colour category, you are prompted to provide a name 

for the colour category that is more meaningful to you.  
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You can create custom colour categories, associate custom colours with the colour 

categories, and assign shortcut keys to the colour categories. Click OK to return to 

the Task window. 

Tip Changed your mind about a colour category assignment? Right-click the 

colour or name of the colour category, then click Clear Name of Category 

or Clear All Categories. 

 

If you do not want other people to see a shared task entry, on the Task ribbon, in 

the Tags group, click Private.  

 If you want to enter mileage, work hours, and other billing information, on the 

Task ribbon, in the Show group, click Details. Type the information in the Total 

work, Actual work, Mileage, and Billing information text boxes. 

 On the Task ribbon, in the Actions group, click Save and Close.  

 

Create a Task or a To-Do Item From an E-Mail 

Message 

There are several ways to turn an e-mail message into a task or a to-do item. 

Do any of the following: 

 Flag an e-mail message for follow-up  

Flagging a message is the best option when you need to quickly mark an item 

for your attention at a later time. When you flag an item, it is displayed in the 

Mail view with a flag, in Tasks, in the To-Do Bar, and in the Daily Task List in 

Calendar.  

 

Flagging a message or contact does not create a new task. Because the to-do 

item still remains an e-mail message or contact after being flagged, you do not 

have the ability to assign it as a task to someone else, or indicate its progress or 

percentage of completeness. 

 

1. In Mail, right-click the flag column for an e-mail message.  

2. Choose the due date.  
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Tip To add a follow-up flag quickly, click the flag column next to the e-mail 

message. A start date and due date of today are set automatically. 

Note To change the reminder time, reminder sound, Start date, Due 

date, or the flag text that appears in the InfoBar, or to clear the 

reminder flag, right-click the flag column next to the e-mail 

message, and then click Custom or Add Reminder. Both options 

open the same dialog box, but when you use Add Reminder, the 

reminder check box is selected automatically. 
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 Drag an e-mail message to the To-Do Bar to create a to-do item. 

Note The To-Do Bar must be arranged by Start Date or Due date to 

use these procedures. 

3. Click an e-mail message to select it, and then drag the message to the task 

list section of the To-Do Bar.  

4. When you see a red line with arrows at each end positioned where you want 

to place the task, release the mouse button.  

 

 Drag an e-mail message to the Tasks button to create a new task. 

When you drag an e-mail message to Tasks in the Folder Pane, you can use all 

of the features of a task item, and the contents of the e-mail message, except 

attachments, are copied to the body of the task. Even if the original e-mail 

message is later deleted, the task, including the copied contents, except 

attachments, of the e-mail message, is still available. 

5. Click an e-mail message to select it, and then drag it to the Task button 

on the Folder Pane.  
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Tip To add the message as an attachment to the task instead of pasting the 

text into the task body, right-click the message and drag it to the task list. 

On the shortcut menu, click Copy Here as Task with Attachment. 

 

6. A new task item window appears, and a copy of the e-mail contents is 

pasted into the task body. The subject of the e-mail message becomes the 

subject of the task. If you want, you can change the subject. 

Note You have now entered enough information to create a task. The 

following steps are optional, but will help you better manage your 

tasks in Outlook. 

7. On the Task ribbon, in the Actions group, click Save & Close or continue 

with the following steps to customize your task.  

8. If you want, set the Start date and the Due date for the task.  

Note If you specify a Start date, the Due date field is automatically set 

for the same day. You can change the Due date to a date that you 

want. 

 

 

FOLLOW THE STEPS AS ABOVE TO….. 

Create a To-Do Item From a Contact 

Flagging a contact is the best option when you need to quickly mark a contact 

for your attention at a later time.  

Flagging a contact creates a to-do item, with the text of the flag in the InfoBar. The 

flagged contact is also displayed in the Tasks list, To-Do Bar, and in the Calendar 

Daily Task List. Flagging a contact does not create a new task item. Because the to-

do item still remains a contact, you do not have the ability to assign it as a task to 

someone else, or to indicate its progress or percentage complete. 

1. In Contacts, right-click the contact.  

2. Point to Follow Up on the shortcut menu, and then select the due date.  

Tip To change the reminder time, reminder sound, Start date, Due date, or the 

flag text that appears in the InfoBar, or to clear the reminder flag, click Add 

Reminder. 
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Create a task in the To-Do Bar 

In Outlook  the To-Do-Bar has to be turned on. You can turn the To-Do Bar 

on or off. In addition, you can choose to display a minimized version of the 

To-Do Bar, which uses less screen space. When you turn the To-Do Bar on or 

off, or minimize it in a specific view, the setting applies only to that view. For 

example, if you turn off the To-Do Bar in the Mail view, it will remain off each 

time you are in the Mail view, including the next time you start Outlook. 

However, it remains on in other views such as Calendar, Notes and Tasks. 

To toggle the To-Do bar on or off, from the Layout group in the View 

ribbon, click the To-Do Bar, and then click Normal, Minimized, or Off.  

To create a new task in the To-Do Bar, click in the Type a new task text box 

(called the Task Input Panel, type a subject for the task, and then press ENTER.  

 

By default, the task will be assigned a due date and start date, which are 

based upon the flag's Set Quick Click setting. When you first install Outlook, 

this setting is configured as Today. 

If you create a task and change the flag to another Due date choice, any future 

tasks that you enter in the To-Do Bar will use the new setting. You can always 

override the choice that is displayed and pick another option. However, when 

you restart Outlook, the first task entered will default to the Set Quick Click 

flag setting. 

Tip To change the default flag setting, right-click a flag in the flag column in 

any view, click Set Quick Click, and then choose the flag setting that you 

want. The options include No Date. Choosing the No Date flag makes the 

item appear in the No Date group in the To-Do Bar. 
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Note You have now entered enough information to create a task. The 

following steps are optional, but will help you better manage your 

tasks in Outlook. 

1. Continue with the following steps to customize your task by double-clicking 

the task in the To-Do Bar.  

2. If you want, set the Start date and the Due date for the task.  

3. If you specify a Start date, the Due date field is automatically set for the 

same day. You can change the Due date to a date that you want. 

FOLLOW THE STEPS AS ABOVE TO…. 

Create a Task In The Daily Task List in Calendar 

The Daily Task List appears only in the Outlook Calendar day and week 

views. To toggle the Daily Task List on or off, in Calendar, select the View ribbon, 

click Daily Task List in the Layout group, and then click Normal, Minimized, or 

Off. 

 

To display only the total number of tasks, do one of the following: 

In Calendar, select the View ribbon, click Daily Task List in the Layout group, and 

then click Minimized 

Point to the top edge of the Daily Task List. When the pointer becomes a , 

drag the edge to the bottom of the window.  

Tip To create new tasks in the Daily Task List, you must use the Normal Daily 

Task List setting. 

 

1. In the Daily Task List, as your pointer hovers, Click to add task is displayed.  
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2. Click any blank space beneath a day column.  

3. Type a subject for the task, and then press ENTER.  

By default, the task will be assigned a Start date and Due date of the day in the 

column above the Daily Task List. In order to change the Start date or Due date 

of the task, you can drag the created task to the day that the task is due. 

Alternatively, instead of dragging the task, you can open the task and then 

change the start and due dates. To do so, you can right-click the task, and then 

click Open, or select the item, press ESC, and then press ENTER. 

If you want to make the task recur, on the Task ribbon, in the Recurrence group, 

click Recurrence.  

FOLLOW STEPS AS ABOVE TO…. 

Complete a Task 

When you have completed a task or no longer need to follow up on an item, you 

can mark it complete. After it is marked complete, it will no longer display as an 

active task in Microsoft Office Outlook 

Do any of the following: 

Click the flag status column in the message list, in Tasks, in the To-Do Bar, or in 

the Daily Task List in Calendar  

 Click the flag status column beside the item.  

Right-click the task in Tasks, in the To-Do Bar, or in the Daily Task List in Calendar 

 Right-click the task.  

 Click Mark Complete on the shortcut menu.  

Double-click the task in Tasks 

 Double-click the task to open it.  

 In the % Complete box, enter 100%.  
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The Status and % Complete fields are linked. If you change the value in one 

field, the value in the other field also changes, according to the values in the 

following table.  

Status % Complete 

Not Started 0 

In Progress 1-99 

Completed 100 

Waiting on someone else    0-100 

Deferred 0-100 

Note If the Complete field appears in the task list — as a column of 

check boxes headed by a check mark — you can select the check 

box for the task to mark it complete. If the Status field appears 

in the task list, you can click Completed in the drop-down list for 

the task. 

Open an e-mail message marked with the task flag 

1. Open the e-mail message.  

2. On the Message ribbon, in the Tags group, click Follow Up .  

a. Keyboard shortcut ALT + H + W + M 

Click Mark Complete. 

Difference between ‘Mark Complete’ AND ‘Clear Flag’ 
Mark Complete  The item remains marked with a follow-up flag, but it is now 

displayed with a strikethrough. If the To-Do Bar or Tasks is configured to show all 

tasks and to-do items regardless of whether or not they are complete, you will 

continue to see the message until you delete it from your mail folders. 

Clear Flag  The flag is removed from the e-mail message, and there is no record 

of the message ever appearing in the To-Do Bar and Tasks. 
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If you want to keep a record of completed items, use Flag Complete. However, 

once you delete the e-mail message, the entire item will completely disappear 

from all Outlook views 

Skip an Occurrence of a Recurring Task 

1. Open the specific occurrence that you want to skip.  

2. On the Task ribbon, in the Recurrence group, click Skip Occurrence.  

Note If you set the recurring task to end after a specified number of 

occurrences, each occurrence you skip reduces the number of 

remaining occurrences by one. 

End Recurrence of a Task 

3. Open the recurring task.  

4. On the Task ribbon, in the Recurrence group, click Recurrence.  

5. Click Remove Recurrence.  

 

 

Quick reference: Keyboard shortcuts for Microsoft 

Outlook  
 

Basic navigation 

To do this Press 

Switch to Mail. Ctrl+1 

Switch to Calendar. Ctrl+2 

Switch to Contacts. Ctrl+3 

Switch to Tasks. Ctrl+4 

Switch to Notes. Ctrl+5 

Switch to Folder List in Folder Pane. Ctrl+6 
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Switch to Shortcuts. Ctrl+7 

Switch to next message (with message open). Ctrl+Period 

Switch to previous message (with message open). Ctrl+Comma 

Move between the Folder Pane, the main Outlook 

window, the Reading Pane, and the To-Do Bar. 

Ctrl+Shift+Tab or 

Shift+Tab 

Move between the Outlook window, the smaller 

panes in the Folder Pane, the Reading Pane, and the 

sections in the To-Do Bar. 

Tab 

Move between the Outlook window, the smaller 

panes in the Folder Pane, the Reading Pane, and the 

sections in the To-Do Bar, and show the access keys 

in the Outlook ribbon. 

F6 

Move around message header lines in the Folder Pane 

or an open message. 

Ctrl+Tab 

Move around within the Folder Pane. Arrow keys 

Go to a different folder. Ctrl+Y 

Go to the Search box. F3 or Ctrl+E 

In the Reading Pane, go to the previous message. Alt+Up Arrow or 

Ctrl+Comma or 

Alt+Page Up 

In the Reading Pane, page down through text. Spacebar 

In the Reading Pane, page up through text. Shift+Spacebar 

Collapse or expand a group in the email message list. Left Arrow or Right 

Arrow, respectively 

Go back to previous view in main Outlook window. Alt+B or Alt+Left 

Arrow 

Go forward to next view in main Outlook window. Alt+Right Arrow 

Select the InfoBar and, if available, show the menu of 

commands. 

Ctrl+Shift+W 
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Create an item or file 

To do this Press 

Create an appointment. Ctrl+Shift+A 

Create a contact. Ctrl+Shift+C 

Create a contact group. Ctrl+Shift+L 

Create a fax. Ctrl+Shift+X 

Create a folder. Ctrl+Shift+E 

Create a meeting request. Ctrl+Shift+Q 

Create a message. Ctrl+Shift+M 

Create a note. Ctrl+Shift+N 

Create a Microsoft Office document. Ctrl+Shift+H 

Post to this folder. Ctrl+Shift+S 

Post a reply in this folder. Ctrl+T 

Create a Search Folder. Ctrl+Shift+P 

Create a task. Ctrl+Shift+K 

Create a task request. Ctrl+Shift+U 

 

Commands in most items 

To do this Press 

Save (except in Tasks). Ctrl+S or Shift+F12 

Save and close (except in Mail). Alt+S 

Save as (only in Mail). F12 

Undo. Ctrl+Z or Alt+Backspace 

Delete an item. Ctrl+D 

Print. Ctrl+P 
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Copy an item. Ctrl+Shift+Y 

Move an item. Ctrl+Shift+V 

Check names. Ctrl+K 

Check spelling. F7 

Flag for follow-up. Ctrl+Shift+G 

Forward. Ctrl+F 

Send or post or invite all. Alt+S 

Enable editing in a field (except in Mail or Icon view). F2 

Left align text. Ctrl+L 

Center text. Ctrl+E 

Right align text. Ctrl+R 

 

 

Mail 

To do this Press 

Switch to Inbox. Ctrl+Shift+I 

Switch to Outbox. Ctrl+Shift+O 

Choose the account from which to send a message. Ctrl+Tab (with focus on 

the To box), and then 

Tab to the Accounts 

button 

Check names. Ctrl+K 

Send. Alt+S 

Reply to a message. Ctrl+R 

Reply all to a message. Ctrl+Shift+R 

Reply with meeting request. Ctrl+Alt+R 
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Forward a message. Ctrl+F 

Mark a message as not junk. Ctrl+ Alt+J 

Display blocked external content (in a message). Ctrl+Shift+I 

Post to a folder. Ctrl+ Shift+S 

Apply Normal style. Ctrl+Shift+N 

Check for new messages. Ctrl+M or F9 

Go to the previous message. Up Arrow 

Go to the next message. Down Arrow 

Create a message (when in Mail). Ctrl+N 

Create a message (from any Outlook view). Ctrl+Shift+M 

Open a received message. Ctrl+O 

Delete and Ignore a Conversation. Ctrl+Shift+D 

Open the Address Book. Ctrl+Shift+B 

Add a Quick Flag to an unopened message. Insert 

Display the Flag for Follow Up dialog box. Ctrl+Shift+G 

Mark as read. Ctrl+Q 

Mark as unread. Ctrl+U 

Open the Mail Tip in the selected message. Ctrl+Shift+W 

Find or replace. F4 

Find next. Shift+F4 

Send. Ctrl+Enter 

Print. Ctrl+P 

Forward. Ctrl+F 

Forward as attachment. Ctrl+Alt+F 
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Show the properties for the selected item. Alt+Enter 

Create a multimedia message Ctrl+Shift+U 

Mark for Download. Ctrl+Alt+M 

Clear Mark for Download. Ctrl+Alt+U 

Display Send/Receive progress. Ctrl+B (when a 

Send/Receive is in 

progress) 

 

Calendar 

To do this Press 

Create an appointment (when in Calendar). Ctrl+N 

Create an appointment (in any Outlook view). Ctrl+Shift+A 

Create a meeting request. Ctrl+Shift+Q 

Forward an appointment or meeting. Ctrl+F 

Reply to a meeting request with a message. Ctrl+R 

Reply All to a meeting request with a message. Ctrl+Shift+R 

Show 1 day in the calendar. Alt+1 

Show 2 days in the calendar. Alt+2 

Show 3 days in the calendar. Alt+3 

Show 4 days in the calendar. Alt+4 

Show 5 days in the calendar. Alt+5 

Show 6 days in the calendar. Alt+6 

Show 7 days in the calendar. Alt+7 

Show 8 days in the calendar. Alt+8 

Show 9 days in the calendar. Alt+9 

Show 10 days in the calendar. Alt+0 
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Go to a date. Ctrl+G 

Switch to Month view. Alt+= or Ctrl+Alt+4 

Go to the next day. Ctrl+Right Arrow 

Go to the next week. Alt+Down Arrow  

Go to the next month. Alt+Page Down  

Go to the previous day. Ctrl+Left Arrow 

Go to the previous week. Alt+Up Arrow  

Go to the previous month. Alt+Page Up 

Go to the start of the week. Alt+Home 

Go to the end of the week. Alt+End 

Switch to Full Week view. Alt+Minus Sign or 

Ctrl+Alt+3 

Switch to Work Week view. Ctrl+Alt+2 

Go to previous appointment. Ctrl+Comma or 

Ctrl+Shift+Comma 

Go to next appointment. Ctrl+Period or 

Ctrl+Shift+Period 

Set up recurrence for an open appointment or meeting. Ctrl+G 

 

People 

To do this Press 

Dial a new call. Ctrl+Shift+D 

Find a contact or other item (Search). F3 or Ctrl+E 

Enter a name in the Search Address Books box. F11 

In Table or List view of contacts, go to first contact that starts 

with a specific letter. 

Shift+letter 
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Select all contacts. Ctrl+A 

Create a message with selected contact as subject. Ctrl+F 

Create a contact (when in Contacts). Ctrl+N 

Create a contact (from any Outlook view). Ctrl+Shift+C 

Open a contact form for the selected contact. Ctrl+O 

Create a contact group. Ctrl+Shift+L 

Print. Ctrl+P 

Update a list of contact group members. F5 

Go to a different folder. Ctrl+Y 

Open the Address Book. Ctrl+Shift+B 

Use Advanced Find. Ctrl+Shift+F 

In an open contact, open the next contact listed. Ctrl+Shift+Period 

Find a contact. F11 

Close a contact. ESC 

Send a fax to the selected contact. Ctrl+Shift+X 

Open the Check Address dialog box. Alt+D 

In a contact form, under Internet, display the Email 1 

information. 

Alt+Shift+1 

In a contact form, under Internet, display the Email 2 

information. 

Alt+Shift+2 

In a contact form, under Internet, display the Email 3 

information. 

Alt+Shift+3 

 

Tasks 

To do this Press 

Accept a task request. Alt+C 
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Decline a task request. Alt+D 

Find a task or other item. Ctrl+E 

Open the Go to Folder dialog box. Ctrl+Y 

Create a task (when in Tasks). Ctrl+N 

Create a task (from any Outlook view). Ctrl+Shift+K 

Open selected item. Ctrl+O 

Print selected item. Ctrl+P 

Select all items. Ctrl+A 

Delete selected item. Ctrl+D 

Forward a task as an attachment. Ctrl+F 

Create a task request. Ctrl+Shift+Alt+U 

Switch between the Folder Pane, Tasks list, and To-Do Bar. Tab or Shift+Tab 

Flag an item or mark complete. Insert 

 

Send/Receive 

To do this Press 

Start a send/receive for all defined Send/Receive groups 

with Include this group in Send/Receive (F9) selected. This 

can include headers, full items, specified folders, items less 

than a specific size, or any combination that you define. 

F9 

Start a send/receive for the current folder, retrieving full 

items (header, item, and any attachments). 

Shift+F9 

Start a send/receive. Ctrl+M 

Define Send/Receive groups. Ctrl+Alt+S 

E&OE 

STL Training reserves the right to revise this publication and make changes from 

time to time in its content without notice. 
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